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Preface
We’ve got so used to a certain way to find files, folders and emails in our 
machines we don’t even notice how much time we waste going from 
drive to drive and folder to sub-folder to sub-sub-folder trying to find 
what we need. That’s because it usually takes just a minute or two. But 
add up the many minutes in a day and we end up wasting many days in 
a year. It could be worse. The wastage is greatest in situations like these:

l	 Looking for an old file we haven’t recently used.

l	 Looking for something we’d downloaded a while ago.

l	 Looking for a photo or song saved a while ago.

l	 What’s worse, we sometimes forget we’d created or downloaded 
a file some months or years ago, which could have been fully or 
partly recycled to reduce the time to create a new letter, proposal, 
presentation, design or calculations. That’s sheer waste! 

Not only does Organyze help find files and emails very fast, it takes the 
uncertainty out of the process. The application has been developed 
out of our own need to bring order into the chaos of our world of 
information. We have actually begun to save time. We are also using it for 
automatic backing up of our files and folders and for easy synchronizing 
of information from one machine to another.

We hope you find it useful too. Please visit our website,  
www.organyze.com, to read about how others are using Organyze, and 
to give us your feedback.

Kiron Kasbekar
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C H A P T E R  1 

Introduction

Organyze 2.1 helps you --

l	 Save time by finding files, folders and emails very, very fast. It 
doesn’t matter where the files are saved; Organyze finds them in 
an instant. It is much, much faster than doing a keyword search or 
manually hunting through folders and sub-folders for files you need. 
YOU SAVE A HUGE AMOUNT OF TIME.

	
m	 Organyze helps you do this through tags (bookmarks, labels and 

comments), which you can attach very easily (in the Organyze 
window, in Windows Explorer, in Word, Excel, PowerPoint and MS 
Outlook, and while downloading web pages in Internet Explorer). 

m	 You can simultaneously apply multiple tags to many files, folders 
or emails.

m	 Find files, folders, and emails easily, without trying to remember 
where you’ve saved them.

m	 Find valuable old files and emails you’ve completely forgotten 
about, and reuse previously created content instead of creating 
it all over again. (To read how, see the chapter: ‘Suggestions’.)

l	 Make more efficient searches  
m	 Quick, multiple label-based search from anywhere (desktop, 

Organyze, while working in other applications), to get a list of 
files, folders and emails instantly.

m	 Advanced search to narrow down the search, based on folder 
selection, keywords (in titles, content, comments or emails), file 
formats, size and dates, plus multiple labels.

l	 See tag details related to files as you take the cursor down a file list 
to quickly zero in on the files you need.
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l	 Manage your files, folders and emails by getting a single, flat list 
of files from different drives, folders and sub-folders; see different 
folders in different panes in the same window to make comparison 
easy; find duplicates at the push of a button.

l	 Import labels from others and share your labels with others to make 
the labeling easy and uniform.

l	 Enhance sharing by sending and receiving messages with file 
attachments, along with bookmarks, labels and comments.

l	 Automatically back up your files daily in your machine or on the 
LAN, or online (by automatic FTP, or file transfer protocol) to keep 
them doubly safe without spending any time at all.

l	 Synchronize folders between two or more machines along with 
the tags (bookmarks, labels, and comments attached to the files and 
folders).

To see the power of the software, please spend a little time creating 
labels according to your preferences and needs, and then attaching 
them to all your important files. After that, see how FAST Organyze 
fetches your files on, say, double-clicking on a label or with the 
other search options. 

There is much more to these features – you will find the info on the 
website – www.organyze.com. For example, tips on labeling and 
comments, and how to use the software for your specific needs. 
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C H A P T E R  2 
Specifications

l	 You need the Windows operating system to be able to use Organyze 
2.1. For Organyze to work fully, you need Windows XP, Vista or 
Windows 7. If you are still using Windows 2000, everything will work, 
except synchronization.

l	 Organyze is available for both 32-bit and 64-bit machines. For proper 
functioning, please use the Organyze variant that applies to your 
machine.

l	 For Organyze to work, you must have:
m	 Microsoft .NET Framework, part of Vista and Windows 7. If 

you are using Windows XP or Windows 2000, Microsoft .NET 
Framework will download automatically if you do not already 
have it. Please accept Microsoft’s conditions of use.

m	 Microsoft SQL Server Express is usually not available. It will 
download automatically if you do not already have it. Please 
accept Microsoft’s conditions of use. 

m	 Microsoft Sync Framework, part of Vista and Windows 7. If you 
are using Windows XP, Microsoft Sync Framework will download 
automatically if you do not already have it. Please accept 
Microsoft’s conditions of use. If you are using Windows 2000, the 
Organyze Synchronization module will not work on your machine.

l	 The speed of Organyze will depend on how much RAM you have; over 
2GB is recommended. A machine speed of around 2GHz is fine; more 
is better. It will also work with less machine speed and RAM, but will be 
slower. But, hey, that’s what happens with any program you use!

l	 If you intend to do daily backing up of your files and folders, and 
also maintain many versions of these, please select disks and 
drives (partitions) with enough space for backup to happen 
unhindered for a reasonably long time.
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C H A P T E R  3 
Guidance on installing and  
uninstalling

First time installation
l	 During installation, remember to do these things:

m	Select the ‘I agree’ button to accept the license agreement

l	 If you have an earlier version of Organyze, you will have to uninstall it 
before you install the latest one. 

l	 	Before you uninstall, please go to ‘Back up’ in the top menu, and 
click on ‘Application data backup’ – and back up the application 
data (which includes data related to labels, comments, and 
bookmarks you have already created and attached, and your 
backup, sync, and other settings). If you do not do this, you may 
lose your recently created labels, comments, and bookmarks, and 
various settings, including your backup and synchronization presets.

l	 If you use more than one log-in for your machine (e.g., as a user and 
as an administrator), please use the log-in with administrator rights 
for the uninstall and install actions. 

l	 Use the ‘Add or Remove Programs’ route to uninstall the previous version.

l	 After installation is complete, you may begin using Organyze from 
any login.

l	 However, before you can actually start the first time, you will 
have to validate your acquisition of Organyze. For this, you must 
be connected to the Internet. Enter the user name (email) and 
registration code. Validation will happen instantly if you have used 
the correct user name and registration code.
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	l	 	After this, Organyze will ask you to identify the location to 
which it should automatically back up your application data. You 
cannot proceed until you do this – the purpose of this condition 
is to ensure that the work you do (creating and attaching labels, 
comments and bookmarks, and various settings, including your 
backup and synchronization presets) is not lost because you have 
forgotten to set up the application data backup. Please set a time 
at which your machine is normally on. Do not worry; the backup 
happens very fast. 

		 Ideally, select a drive other than the C drive, because that’s 
the drive that may have to be formated if you’re reloading 
your operating system or for any other reason. In any case, 
save the application data backup files outside your Organyze 
program folder just in case you need to install a newer version of 
Organyze without using a patch.

		 The scheduled, automatic backup will keep adding fresh versions to 
the previous backups up to the number of versions you have asked 
Organyze to maintain. Once the set number of versions is created, 
with every new backup the oldest version will get deleted. Do not 
set too many versions unless you need them because that will use 
up disk space uselessly. A good idea is to maintain more (say, 5 to 
10) versions for current folders, where you are actively modifying 
files and may wish to bring back something you have deleted 
recently. With archived folders (or folders that you do not use much) 
maintaining two versions should be enough.

		 If you use an external disk for backup, please remember to check that it 
is connected at the time when backup is scheduled to happen.

l	 The size of such backup files will not be more than 1MB to begin 
with, but will grow as you create and attach more bookmarks, labels, 
comments and synchronize and backup configurations. So set the 
number of versions to a level you think is optimal.

l	 Once you have done that, Organyze will close. 

l	 Now you can start it again. You are ready to go!
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C H A P T E R  4 
Finding files, folders, and emails 
instantly

Organyze offers several methods to find the files or folders you need:

1.	 Quick search by 
selecting multiple 
labels: The Quick 
search option is 
the one you see 
when you launch 
Organyze. Just 
enter the names 
of the labels you 
want (Organyze 
will prompt you 
as soon as you begin writing), select the ‘OR’ or ‘AND’ option if you 
have selected multiple labels, and click on the Search button. The 
list of all the files with the selected labels attached to them will 
show instantly, regardless of where (folder, drive, or disk) the files 
are saved. Please note: this is a search on the basis of labels, not a 
keyword search.

2.	 Very fast retrieval by single label: In the section ‘Advanced search / 
manage’ go to the pane on the left marked ‘Labels’, and double-click 
on a label. (To go to a label, just start typing the label you desire, and 
the cursor will quickly move to the desired area of the pane.) That’s it. A 
list of all files with that label will appear almost instantly – irrespective 
of where (folder, drive, or disk) the files are actually located. 

		 You can only do this one label at a time – but no other search can 
currently match the speed of this method. 

		 Note: To quickly find a label that is inside a parent label, first go the 
parent label and open it (click on the ‘+’ sign) to show the labels 
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inside; then start typing the 
name of the label you want, and 
Organyze will take you there.

		 You can see all your labels in 
one place – so that you can 
double-click on any one to get 
all the files or folders with that 
label attached. You get the list 
instantly; it does not matter 
where the files or folders are 
located.

3.	 Very fast retrieval by multiple 
labels: Under the ‘Search’ bar 
you will see a link ‘By label’. When you click this link, a list of labels 
with check boxes will open up. Select the labels you want, and then 
click on the ‘Get list’ button below the label list. The list of all the 
files (or folders) with the selected labels attached to them will  
show instantly.

4.	 Fast retrieval by multiple labels and filters: Select the labels 
you want by checking the check boxes in the label list in the 
‘Search’ pane (as in the previous method), make one or more of the 
other choices in this pane (including selecting one or more folder; 
entering a keyword to be found in a file title; content or an email; 
file size; date range and whether a bookmark has been attached) 
and then click the ‘Get list’ button below the label list. The list of all 
the files (or folders) with the selected labels attached to them, and 
which conform to the filters you have set, will show instantly.

These methods work only if you 
have attached labels to files, and 
seek a list of labeled files. (In the 
enterprise version, Organyze will 
fetch relevant files from all the 
machines to which your machine 
has access, provided these machines 
also have Organyze installed in them. 
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Also, in the enterprise version, one 
person can do the labeling centrally, 
and everybody else can use the 
system, besides using their own 
personal labeling.)

5.	 Keyword search in multiple 
sub-folders, folders and drives: 
This works pretty much like the 
Windows keyword search, with 
these differences: 

m	 You can select multiple 
folders and sub-folders in 
different folders and drives 
(and different machines, in 
the enterprise version). 

m	 You can select the file 
formats you want, or get a list 
of folders only.

m You can also use multiple 
keywords with and / or 
options.

m Select bookmark and/or one 
or more lables as criteria.

m You can get emails in your 
results along with files and 
folders!

6.	 Single flat list: This works 
pretty much like the Windows 
keyword search (with a BIG 
difference – you can select 
multiple folders and sub-folders 
in different folders and drives); 
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easily select the file formats 
you want, or get a list of  
folders only.

 
When you seek file lists, the default 
will fetch you all the files in the 
selected folders. To reduce the size 
of the list, you can use various filters 
to narrow the search. These include:

m File format. 

m Keywords (through one or 
more option of searching 
for keywords in the  
filename, in the file content, 
through comments 
attached to files, and 
through emails in MS 
Outlook).

m Date (last week, last month, 
past year, or a date range).

m File size (less than 100KB, 
less than 1MB, more than 
1MB, or a minimum size 
you can specify) by multiple 
labels. 

m Select bookmark and/or one or more lables as criteria.

Read more on this in the next chapter - ‘Single list from multiple folders’.
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C H A P T E R  5 
Single list from multiple folders

Organyze enables you to get a single list of files from multiple  
sub-folders, folders, drives, disks, and machines. The uses: 

	l	 This helps in housekeeping as well as in locating files quickly 
because you don’t have to go through many lists, one folder or  
sub-folder at a time. 

	l	 It also helps you narrow down the search results because you are 
not forced to search through an entire drive or large folder; you can 
select only a few separate sub-folders for the search.

	l	 You can use filters to narrow down the list (as discussed in the 
previous chapter).

In order to select multiple folders in one or more drives, click in the 
check boxes before the folders and sub-folders. Remember, the more 
folders you add to the selection, especially heavy ones, the more time it 
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will take to fetch the list. Also, the more folders you select, the longer the 
list will be. To get the best results, be selective.

Organyze supports all file formats:
	l	 Image:  jpg, jpeg, bmp, png, gif, and psd.

	l	 Video: aaf, 3gp, asf, wmv, avchd, avi, cam, dat, dsh, flv, m1v, m2v, fla, 
flr, sol, m4v, mkv, wrap, mng, mov, mpeg, mpg, mpe, mp4, mxf, roq, 
nsv, ogg, rm, svi, smi, swf, and wmv. 

	l	 Audio: mp2, mp3, mpeg, gsm, wma, m4a, mp4, m4p, aac, mpc, vqf, 
ra, rm, ots, swa, vox, voc, dwd, and smp. 

	l	 Document: abw, acl, afp, ans, aww, cwk, doc, dot, egt, ftm, hwp, lwp, 
mcw, nb, nbp, txt, odt, and pdf. 

	l	 Presentation: key, nb, odp, otp, pps, ppt, prz, shf, sspss, sxi, keynote, 
nbp, pptx, and watch. 

	
	l	 Spreadsheet: 123, aws, clf, csv, numbers, gnumeric, ods, ots, qpw, slk, 

stc, sxc, tab, vc, wk1, wk3, wk4, wks, wq1, xlk, xls, xlr, xlt, xlsb, xlsm, 
xlsx, xltm, and xlw. 

	
	l	 Webpage: htm, xht, xml, mht, asp, adp, bml, cfm, cgi, ihtml, jsp, las, 

lasso, pl, php, html, xhtml, mhtml, aspx, lassoapp, shtml, and phtml.

	l	 For all other formats: If you wish to select any other format, please 
enter the file extension in the ‘Others’ text box (e.g., cad); enter more 
than one such file extension with a comma to separate them.
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C H A P T E R  6 
Manage files, folders, and emails

Opening files
You can open a file in its original program by double-clicking on the 
filename in the lists displayed in the Organyze window. 

Copy, move, delete files 

You can copy and paste, rename, move and delete files and folders in 
the Organyze window. Remember: whatever you do in the Organyze 
window or in the Explorer panes inside the Organyze window 
will reflect in your computer. So, if you delete a file in the Organyze 
window, it will get deleted from your machine. Similarly, your rename, 
copy and paste, and move actions will reflect in your machine.

Note: 	 When you rename or move a file or folder in the Organyze 
window (including in the Explorer panes within the Organyze 
window), the tags you have previously attached to the file or 
folder will remain intact and connected. If you rename or move 
a file or folder in Windows Explorer, the tags will get detached. 
But don’t worry, next time you double-click on the concerned 
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labels you will be 
informed about the 
error, and helped 
to re-connect the 
labels quickly and 
automatically.

Manage emails
With Organyze, you can 
retrieve emails from MS 
Outlook the same way as you 
search for files and folders – 
through the use of bookmarks, 
labels, and comments, besides 
using keywords and various 
other ways of widening or 
narrowing down the search. 

Email search through  
Organyze
l	 Search through a 

selection of email folders 
(e.g., inbox, sent, or one 
or more of folders you 
have created) by simply 
checking check boxes 
with these folder names.

	l	 Attach bookmarks, 
labels, and comments 
to your emails while 
you are working on 
them in MS Outlook.

	l		 Attach one or many 
bookmarks, labels, and 
comments to a multiple 
selection of emails in 
your MS Outlook inbox or sent or other email folders.

Organyze tool bar in MS Outlook
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C H A P T E R  7 
Find duplicates

Once you have got a list of files in the Organyze window, you can ask 
the Software to find duplicates for you either from a selection of files 
or through the entire list. The duplicate files will show in similar colors. 
Organyze will show two duplicate files as duplicate even if their  
filenames are different.

You can delete duplicates you don’t want. Do, however, take care of 
these things:

	l	 When you have a series of related files with duplicates located in 
other folders, you may wish to ensure that all the copies you retain 
reside in one folder. To avoid deleting some duplicate related files 
from one folder and some others from other folders (which would 
leave them scattered all over the place), you can open multiple 
panes within the Organyze window, which will show you the 
Windows Explorer views of the folders and files. 
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	l	 Use the single list of Organyze (with duplicates showing) to  
see the duplicates, and then delete unwanted duplicates from the 
lists showing in the Windows Explorer panes. This is only an option. 
If you are working with a relatively short list, you may be able to 
weed out duplicates without opening the additional panes.

Note 1: 	 The compare, find duplicates, and export functions are 	
available only in the Organyze pane.

Note 2: 	 You do not need to maintain any orderly system to find files; 
Organyze gets you files wherever they are located (provided 
you have added various tags to the files). But orderliness is 
useful when you are backing up and synchronizing – so you 
can back up (and restore) or synchronize blocks of related files.

Note 3: 	 Many of the duplicates may turn out to be images, scripts and 
other components of html pages, which are normally stored in 
folders with the same names as the html files they represent. 
If you delete these components, the html files may not open 
properly.
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Comparing files
Select any two files and click on the ‘Compare files’ button. The program 
will tell you if the files are duplicates or not.
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C H A P T E R  8 
File / folder details

When you take your cursor to a file in a list displayed in the Organyze 
pane of the ‘Manage files / folders’ module, you will see tag details 
related to the file in the left panel, in the pane under the heading 
‘Details’. The details seen include the number of items selected, the  
filename or names, whether the file is bookmarked, and the labels and 
comments you have attached to the file.

When you select many files in the displayed list, the Details pane will only 
show you the number of items selected, and the names of the selected 
files. You can see the other details by clicking on the ‘Show details’ button 
inside the pane and the details of all the files will be displayed in a tabular 
format in another window – including filename, comments, labels, 
bookmarks, path, created date, last modified date, type, size, number of 
sub-folders (if you have selected folders), and number of files.

Such a detailed listing 
can be useful for your 
housekeeping. You 
can see if, in a list of 
related files, some file 
is missing, which you 
then need to move 
from somewhere 
else, or acquire from 
a colleague or friend, 
or download from 
the Web.

Export list, details
You can export the 
tabular list to Excel 
for printing. This 
can aid you in your 
housekeeping.
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C H A P T E R  9 
Multi-pane view

The ‘Manage files / folders’ function of Organyze allows you to open 
multiple panes in the same window. These include:

l	 The main Organyze pane.

l	 Clicking on the Explorer icon immediately above the Organyze pane 
opens a Windows Explorer pane.

l	 When you do that, another Explorer icon appears, clicking which will 
open one more Windows Explorer pane. 

Click on the red cross box to close the pane.

Other features
l	 You can also get the Explorer view in another window by clicking on 

the Explorer icon in the top toolbar.
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l	 You can choose to work either in the Organyze pane or in the 
Explorer panes. You can do both if you like.

l	 You can open files by double-clicking on the filename in the lists 
displayed in the Organyze window – in the Organyze pane and in 
the Explorer panes.

Note 1: 	The compare, find duplicates, and export functions are 	
available only in the Organyze pane. 

Note 2:	You can see details only for selections in the Organyze pane.

Previews
You can see previews of images as you take the cursor down a list in the 
Organyze pane. This helps to identify the file you need; it also shows up 
the duplicates when you do a search for duplicates. If you do not need 
the previews, just click on ‘Preview off’.
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C H A P T E R  1 0 
Creating and managing labels

There are three ways in which you can create new labels. One is by the 
Labels > Manage labels route; when you click on ‘Manage labels’, you 
will see a pop-up showing your existing labels in a hierarchical structure. 
The second way is to do it ‘on the fly’, that is, while you are trying to attach 
a label to a file. And the third way is when you are in the ‘Import labels’ 
window (see chapter ‘Export / Import labels’). 

When you are in the process of tagging a file, and find that there is one 
more label you should attach to it but that label doesn’t exist, just go 
ahead and create it while you are still in the labeling mode. The method 
in all these ways is the same:

l	 Select any label under which you wish to create a new label, and 
click on ‘Add new’. You will get a text box (‘New node’), Which lets 
you enter the name of the new label you wish to create. Enter the 
new label name, and click outside – the label gets created. 

l	 If you have made a mistake, say, a spelling mistake, right-click on 
that label and click on ‘Edit’, and you can correct the spelling. 

l	 When you create a new label, it will appear at the bottom of the list within 
the level to which it belongs, instead of in alphabetical order. When you 
re-open the label list, the new label will be in its alphabetical order.

l	 You can also modify a label (e.g., change its spelling, or shift a 
label from one parent label to another, as in shifting ‘technology’ 
from inside a parent label ‘industry’ to inside another parent label 
‘manufacturing’). The changes will automatically apply to all the files 
that have been tagged with that label.

l	 You can also use the same label name (e.g., technology) many 
times to get more precise results (in this case, by placing a 
‘technology’ label under the ‘chemicals’, ‘automotive’, ‘aerospace’, and 
‘pharmaceuticals’ parent labels).
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C H A P T E R  1 1 
Attaching tags (bookmarks,  
labels, and comments)

There are many ways in which you can use and create tags with 
Organyze (bookmarks, labels, and comments). They are: 

1.	 Attach tags directly while working in an MS Office program (Word, 
Excel, PowerPoint, and MS Outlook) by selecting the bookmark / label 
/ comment links that show in the top toolbar (if it does not show, go to 
View > Toolbars and select the ‘Organyze’ toolbar). 

         If you have not saved a (new) document before, Organyze will take you 
through the Save routine and then ask you to attach the bookmark, 
label, or comment. If the file has already been saved, go directly to 
the label, bookmark, and comments icons and attach the tags.

		 You can turn the Organyze toolbar icons off doing this:

		 In MS Office 2000 or 2003: click View > Toolbars and select (or 
unselect) Organyze. But, while turning it off, do not remove it 
from the toolbars customize menu; if you do that, you will not be 
able to restore this function again.

		 Advantages while working in a file:
m	 A view of the content gives you a better idea about which labels 

to attach or what comment to write. 

m	 You can copy and paste parts of the file content in a comment 
and add your remarks. 

m	 Ideal for first-time tagging of a file since it requires hardly any 
effort at all.

Note: 	 This method works well when you wish to attach tags to one file 
at a time while seeing the contents of the file.
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2.	 Attach tags in the Organyze window. 
m	 You can attach bookmarks, labels or comments to many files at 

the same time.

m	 You can drag and drop one or more files on to the bookmark 
box or to any label in the labels pane on the left to attach these 
tags. To do this with labels, open up the label structure so that 
you can see the label you wish to use; then drag and drop the 
filename on the label. 

Organyze toolbar in MS Office 2010

Organyze toolbar in MS Outlook 2010

Organyze toolbar in MS Outlook 2003

Organyze toolbar in MS Office 2003

Organyze toolbar in MS Office 2007

Organyze toolbar in MS Outlook 2007
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3.	 Attach tags in Windows Explorer. You can right-click on one or more 
filename and attach a tag to the file. 

m	 You can attach bookmarks, labels or comments to many files at 
the same time.

Note 1: 	 You can attach a label to up to 20-30 files simultaneously in 
Windows Explorer, depending on their size (there is no such 
limit when you work in the Organyze window).

Note 2: 	 If you move files or folders from one place to another 
through the original Windows Explorer, the files will lose 
their previously given tags. But don’t worry; Organyze 
helps you quickly restore the tags.

		 When you get a list of files in Organyze using tags, and if there 
are broken links between one or more of those tags and some 
files or folders which you have moved from outside Organyze 
(e.g., in Windows Explorer or an explorer dialog box in any 
application), Organyze will open a pop-up (see Page 24) with a 
list of all the files and folders with the old path.
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Bulk restore
Let’s say you have shifted a folder called Images and Videos with six sub-
folders and 2,000 files in it from your D drive to your E drive in Windows 
Explorer. By doing this, you have broken the links of these folders and 
the files to their tags (bookmarks, labels and comments). 

In the ‘Path missing’ pop-up, select any one file in the ‘Old path’ list, and 
click on the ‘Bulk restore’. You will then be asked to browse and select the 
new location (see below).
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Make sure the last folder name is the same (which will usually be so 
unless you have changed the folder name besides moving it). Click the 
‘Update’ button. 

Your tags will get restored instantly for all files at the same folder level as 
the selected file and for all sub-folder levels below it. In the example given 
above, the missing tag links will be restored for all the files in one shot.

If you have moved some other folders to other destinations, then  
you will have to repeat this process.

Restore one by one 
If the list of files with missing tag links is mixed because you have 
moved too many individual files from different locations to different 
destinations, click the ‘Restore one by one’ button to restore links to one 
file or folder at a time.

4.	 Attach tags directly while working in Internet Explorer. You 
can use Organyze to attach a bookmark, labels and comments to 
a Web page while you are saving a Web page in Internet Explorer 
or when you open a page you have already downloaded and 
saved in your machine. You can do this in one of these ways:

m	 For an unsaved page, click on the ‘Save’ (floppy) icon in the 
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Organyze toolbar at the 
top of the page, and on 
the ‘Label’, ‘Bookmark’ or 
‘Comment’ buttons for an 
already saved file. 

m	 You can also go to the 
top File link, and select 
Organyze > Label, 
Bookmark, or Comment to 
attach the tag you want.

m	 You can do the same 
thing by right-clicking on the page and then attaching the tags 
you want. 

Note: 	 The right-click option is useful especially when you wish to save 
the content of pop-up windows some websites open when you 
ask for a print-friendly page, which do not have the top links 
(File, Edit, View, etc.) you can use to save the pages instead of 
printing them.
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If you are using Windows 7, please make sure that the Protection Mode 
in Internet Explorer has to be set at ‘Off’ for you to be able to use this 
feature of Organyze 2.1.

 To set Internet | Protected Mode off, go to Tools > Internet Options > 
Security (or double-click the ‘Protected Mode’ link)
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5.	 Attach labels, bookmarks, and comments to emails in MS Outlook

m	 In your MS Outlook window select one or more emails to which 
you wish to attach bookmarks, labels, or comments. Click on the 
Label icon on the Organyze toolbar at the top.

m	 The emails will get bookmarked when you click on the 
Bookmark icon. For labelling, a pop-up will open, in which you 
can select the labels that you wish to attach. 

m	 Choose labels that you would like to attach and click on  
‘Attach’ to complete the process. 

m	 When you click on Comment, you will get a pop-up in which  
you can enter a comment and save.

m	 You can also attach labels, bookmarks or comments after 
opening a mail in MS Outlook by selecting from the Organyze 
toolbar at the top.

Note: 	 If you do not see the Organyze toolbar, go to View > Toolbars 
and select Organyze; the Organyze toolbar will now appear 
at the top. If Organyze is already selected in the toolbar menu 
but you still cannot see the toolbar (this may happen if you 
have a crowded set of toolbars), then click on the icon at the 
right of the whole toolbars panel of the page, and drag it to 
the main toolbar area. If you are unable to do this, then go to 
View > Toolbars, and see if ‘Lock the Toolbars’ has been selected. 
Unselect this to unlock the toolbars, and then drag the Organyze 
toolbar to the main toolbars area. You can lock the toolbars now, 
if you like.
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C H A P T E R  1 2 
Recently used 
files, recently 
tagged items

Organyze 2.1 offers you yet another 
way to find files very fast!
 
Recently used files
We often forget which files we have 
worked on recently and where they are. 
Organyze helps you quickly get a list of 
files which you have recently opened, 
created, or modified. They will show in 
a single list regardless of where they 
are actually located.

You will see the button ‘Recently 
used files’ in the left panel. Just click 
it, and you will instantly get a list of 
all the files you have used recently 
(including files you have merely 
opened and closed without working 
in them).

Recently tagged items
Organyze also helps you find files, 
folders, and emails you have tagged 
recently. They will show in a single list 
regardless of where they are actually 
located.

You will see the button ‘Recently 
tagged items’ in the left panel. Just click 
it, and you will instantly get a list of all 
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the files, folders, and emails you have tagged recently. 

Items will show even if you have not opened a file but merely attached 
a tag from anywhere outside the file (e.g., in the Organyze window, in 
Windows Explorer, or a MS Outlook list)

Note: 	 Please do not confuse these lists with the ‘Recent documents’ 
feature in Windows, which displays shortcuts to your latest 
files. If you delete a shortcut, the file remains. The lists you get 
in Organyze are not shortcuts. So please do not delete them 
unless you actually wish to delete the file itself. 
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C H A P T E R  1 3 
Understanding tags

Organyze lets you tag files, folders, and emails with three types of tags – 
bookmarks, labels, and comments. 

Bookmarks
Bookmarks are simple tags that can only signify that the tagged file 
is relevant or useful, or of a certain priority. Bookmarks are very useful 
because you can attach a bookmark very fast, and bookmarked items 
can be found instantly. You can improve your search by combining 

bookmarks with other 
filters (folders and 
sub-folders, file formats, 
keywords, email folders, 
comments, date, size, 
and labels).

To bookmark one or 
many selected files in the 
Organyze window, just 
drag them to the box 
titled ‘Bookmark’ in the 
left panel – and they will 
be bookmarked. Or right-
click on the selection and 
then choose ‘Bookmark’ 
in the menu you get. 
You can also attach 
bookmarks when you 
are in an MS Office file, in 
Windows Explorer, or in 
Internet Explorer.

To find bookmarked 
items, simply click 
on the box titled 
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‘Bookmark’ in the left panel, and you will instantly get a list of all 
bookmarked files, folders and emails. 

You can remove bookmarks whenever you wish to do so. Click on the 
box titled ‘Bookmark’ in the left panel, get a list of all bookmarked items, 
and detach bookmarks from those you wish to un-bookmark. You can 
also remove bookmarks when you are in an MS Office file, in Windows 
Explorer, or in Internet Explorer. 

Labels
Labels too are tags, but they can provide many meanings by having 
different names (see ‘types of labels’ below). So you can distinguish one 
set of labeled files from another because of their different labels. 

Types of labels 
You can get much more out of labels if you think of different types of 
labels. We suggest at least two broad types: 
l	 Labels that describe the content of a file (i.e., the subject). So you 

can have labels like finance, marketing, advertising, ‘Ford Motor’, or 
‘innovation’, or even ‘material for conference’. 

l	 Labels that describe a file’s process or score (e.g., status, priority, 
score, etc.). 
1.	 Status descriptions could include terms like ‘sent for approval’, 

‘approved’, ‘final’, ‘emailed’, or even ‘label later’.
2.	 Priority descriptions could include terms like ‘urgent’, important’, 

‘archived’.
3.	 Score descriptions (usable in assessing tests or job applications, 

for example) could include terms like ‘excellent’, ‘good’, or ‘bad’.

Creating / editing labels
Organyze allows you to create a hierarchical structure of labels to allow you 
to classify and better organize them. Keep the labels short to avoid scrolling.  

Label arrangement
You can find labels in various ways:
l	 The normal view of labels is the hierarchical (‘tree view’) structure; but 

you can change it to a simple alphabetical list whenever you want. 
When you are in the Organyze window in the ‘manage files / folders’ 
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window, you can see the labels on the left. They are displayed in a 
hierarchical format by default (if you have chosen to create a hierarchical 
or ‘tree’ structure for the labels, which we strongly recommend). 

l	 The advantage of 
being able to attach 
labels arranged in a 
hierarchical structure 
is that you can use 
the same label name 
to mean different 
things. For example, 
you can have a 
label ‘technology’ 
under a parent 
label ‘chemicals’, 
and another label 
‘technology’ under 
a parent label 
‘aerospace’. When 
you double-click the label aerospace > technology, you will only 
get the files related to aerospace technology and not chemicals 
technology. This improves the relevance of your search results.

	l		 To go to the simple alphabetical listing, in the Organyze window 
right-click on any of the labels in the left pane, and select ‘List view’. 
In this view, it’s easier to find files by selecting the alphabet with 
which your label begins. If you 
have used the same-named label at 
different levels in the label hierarchy 
(e.g., ‘technology’ at the basic level 
and also under ‘aerospace’ and 
other industry labels) you will see 
the label twice (or more) in the 
alphabetical list. 

l	 In all other display formats (in the Explorer pane in the Organyze 
window, in Windows Explorer, in MS Office, or in Internet Explorer) you 
can see the labels only in the tree view arrangement. 
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Note: 	 What are those numbers in brackets next to the labels?

The number in brackets next to the title ‘Labels’ in the title band is the 
total number of your labels. If you right-click on any label inside the pane 
and select ‘Show attached count’, you will see a number next to that 
label indicating the number of files with the ‘parent’ label attached, and 
a second number indicating the total number of files with both ‘parent’ 
and ‘child’ labels. The total number of label attachments in your entire 
system is shown in brackets after ‘Labels’ at the top inside the pane.

Comments
Organyze allows you to attach comments to files, which you can see 
without opening the files. So, when you run down a list of files in the 
Organyze window (by moving the cursor down the list), you will see the 
comments (along with other details, such as labels) in the panel on the 
left under the heading ‘Details’. 

Advantage: 
l	 You may have many versions of a report you are drafting. Some 

drafts may have come back from colleagues with their comments. If 
you are looking for one of these, you can identify it by looking at the 
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comment in the Details pane instead of opening the file. That can 
save you a lot of time (provided, of course, you or your colleagues 
have attached comments to the files). You should also find this 
method useful in other ways — for example, finding photographs 
taken on a holiday by looking for keywords in comments describing 
details of the photographs!

l	 You can see all previous comments attached to a file or folder. 

l	 What’s more, you can do a keyword search through comments. That 
helps because you may be looking for remarks made by a colleague, 
saying, for example, “These figures seem outdated. Could you add 
the latest numbers?” That may be the draft in which the colleague has 
also marked some paragraphs for revision. So if you remember the 
comment, you use the keyword ‘outdated’ or ‘figures’, and you will find 
the file; it doesn’t matter where you have saved it, or when. 

Note 1: 	 You can attach a comment to a file of any format – including 
images and videos. That’s a big help because while you can 
add remarks inside a Word or Excel file, you cannot easily write 
remarks inside an image, flash, audio or video; and even where 
you can do that you cannot see them until you open the file. 
So, Organyze helps to improve the ease of finding files by 
letting you see comments without opening the files.

Note 2: 	 You can have multiple comments attached to a file.
 
Note 3: 	 For your colleagues or friends to attach comments to a file 

they are sending you, they too must have Organyze installed 
on their machines. If they don’t, you will have to jot down their 
remarks as comments and attach them to the received files.
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C H A P T E R  1 4 
Automatic labeling

You can ask Organyze to label files automatically. Open Windows Explorer, 
right-click on a folder, and in the Organyze menu select ‘Automatic labels’. 

	l		 With the help of the check boxes, you can select all or only some 
sub-folders in a folder for automatic labeling (default is all). 

l	 Organyze will ask you whether you wish to automatically label all the 
files inside the folder or only select formats.

 
l	 Click on the ‘Start’ button (and confirm okay), and Organyze will 

immediately label all files in the folder (including its selected sub-
folders) with the names of all the parent folders upstream of the files.

How it works: If you are trying to automatically label files in a 
main folder called ‘Marketing’, in which you have sub-folders called 
‘Advertising’ and ‘Promotion’, and the Advertising sub-folder has a sub-
sub-folder called ‘Ad agencies’, then all the files in the sub-sub-folder 
called Ad agencies will automatically get these labels attached to them – 
Marketing, Advertising, and Ad agencies (but not ‘Promotion’).

This automatic feature can be very useful for labeling older files. 

But please remember this – you may end up with odd-sounding labels. 
And you may end up with too many same-name labels in parallel. On the 
other hand, if you use this automatic feature carefully, it could save you a 
huge amount of time.

Note:  	 To avoid clutter caused by too many same-name labels, try this:
		 Let’s say you have a label ‘Innovation’ under a parent label 

‘Management’, and your automatic labeling shows up another 
label ‘Innovation’ because that is the name of a folder or sub-
folder somewhere in the path of your automatic labeling. 

		 To clean up, after the auto-labeling is done, call all the files with 
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the auto-labeled ‘Innovation’ label (it will be a separate label, 
not under ‘Management’). Then select all the files (except those 
you think do not really fit the description ‘Innovation’ though 
you may have dumped them in the innovation sub-folder for 
convenience while downloading), and do this –

		 Detach the new ‘Innovation’ label; attach the ‘Innovation label’ 
under the ‘Management’ parent label; then delete the auto-
created ‘Innovation’ label. That will delete the label and also 
remove the ‘Innovation’ label from the files you decided should 
not be tagged with the ‘Innovation’ label.
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C H A P T E R  1 5 
Export / import labels

We know it can be a pain thinking up label names. So we will soon create 
a label bank (see below) on the Organyze website from which you can 
import and select the ones you would like to use. In the meanwhile, the 
Organyze package that you install will come ready with a basic list of 
labels, so you do not have to begin from scratch!

If you do not want any of the labels we have provided, just go to ‘Manage 
labels’ and remove or modify them. And, of course, add your own!

You can also import labels from colleagues or friends who have already 
created a good label structure for their use. Once you have a good collection 
of labels, you too can export them to other colleagues or friends. 

Exporting labels: To export your labels, use the link Labels > Back up labels. 
When you select the place to back up the labels, and click on the ‘Take 
backup now’ button, Organyze will create an XML file and store it in your 
selected location. You can then send it to a colleague or friend for them to 
extract the labels they need. (Remember where you have saved the XML file.)

Importing labels: If you have received an XML file containing a 
colleague or friend’s labels, use the path Labels > Import labels to 
browse, get the appropriate XML file (you may have received labels from 
more than one colleague or friend), and click on ‘Get labels’. 

The imported labels will show in the left panel (see snapshot). You can 
add labels from there to your own set of labels (in the right panel) in two ways:

l		 Go one by one, transferring a label from the left side to the right. 

l	 Select an entire group of labels (e.g., Music, under which there 
may be specific labels for different styles of music or names of 
musicians; or Companies, under which there would be names of 
different companies; or Marketing, under which there would be 
different aspects of marketing) and transfer them to the right side. 
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Organyze will check which labels you already have, and add those 
you do not have.

Note 1: 	 Remember to select the group (or single label) on the left and 
the parent (one level higher) on the right before you click on 
the ‘Transfer label’ button. So, if you already have a label group 
called ‘Music’ and the imported label set also has ‘Music’ but with 
more specific labels than you have, select ‘Music’ in the left panel 
and the next higher level in the right panel (which could be 
‘entertainment’, or ‘Labels’ (the root). If you select ‘Music’ on both 
sides, then a new label set called ‘Music’ will be created within 
your already existing ‘Music’ label set, which is not desirable.

Note 2: 	 Your label structure can be different from the one in an 
imported set. The ‘Music’ label set on the left may have only 
the names of musicians under it. But you could create (or you 
may already have) categories like ‘Classical’ and ‘Popular’ under 
music, and pick musicians from the left and place them under 
these categories (classical musicians under ‘Classical’ and pop 
musicians under ‘Popular’.



o r g a n y z e  2 . 1
www.organyze.com

43

Note 3: 	 You can rename the labels to suit your preferences. So, you could 
change ‘Classical’ to ‘Western classical’, place it under ‘Western’, 
and maybe add ‘Jazz’ and ‘Rock’ as additional categories. You 
could have a label called ‘Channels’ under marketing, or you 
could rename it as ‘Dealers’. Use labels that you are most 
comfortable with, applying descriptions that you (or people in 
your organization) use most. That way, you will recall and find 
them very easily when you are looking for files.

Label bank
The label bank will provide you with a choice of thousands of labels 
organized by subject. Go to www.organyze.com and download the label 
groups you need. You will get them as an XML file, which you can save in 
a convenient location. Extract them the same way as you would extract 
labels imported from a friends or colleague (described above); use them 
as they are, or modify them.
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C H A P T E R  1 6 
Instant messaging, sharing

Organyze brings you instant messaging within the local network in 
your office or at home (if you have more than one connected machine). 
Write a message, select one or more contacts in the network, and send. 
Receive messages (including replies to your messages) from others.
 
With file attachments
You can attach a file to a message. Choose to send (or not to send) 
bookmarks, labels and comments along with the attached file. Receivers 
have the option to reject the file and/or the tags (bookmarks, labels and 
comments) that come with it, or accept them, and to save the file in an 
appropriate folder so that they can see the tags on their own machines.

Format message text
You can format the instant message text with formatting like bold, 
italics, underline, and font colors. This feature can help you highlight and 
emphasize some parts of the text so they are not missed.

Search / advanced search through messages
Find previous messages and conversations by asking for a simple listing, 
with qualifications like date range of the messages, all / only received / 
only sent messages, only messages sent by or sent to selected contacts 
or all contacts. You can also do a keyword search through the messages 
to find the right message, along with or without the above qualifications.

Share comments
With instant messaging, you can see comments attached to a file sent 
by someone else. Others can see comments you have attached with files 
you have sent. Of course, both sender and receiver must have Organyze 
installed on their machines.
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C H A P T E R  1 7 
Emailing files with tags

You can send files along with their tags (bookmarks, labels, comments) 
to other users directly from the Organyze window. Simply select the 
files you wish to send and click on the ‘Zip & email’ button. A pop-up will 
open (see snapshot); you may protect your files with a password if you 
wish. You can also decide which tags (some or all) you would like to send 
along with the files. 

If you are using MS Outlook (NOT Outlook Express), you can choose to 
‘Save and send via Outlook’ option and click on ‘Save and send email.’ 
You will be asked to choose the location to save the zip file, which will 
automatically get attached to the new email; you can write your email 
message and send the mail.
 
Alternatively (if you are not using Outlook), you can choose the ‘Save to 
hard disk’ option, and then attach the saved zip file to your email in any 
other email system.

When you, as a receiver, receive such a mail you must save the zip file 
in your hard disk. To see the contents of the zip file, right-click on the 
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Organyze icon in the ‘system tray’ (at 
the bottom right of your screen), and 
click on ‘Extract’.

You will be asked to select the zip file; 
once you do that, click on ‘Extract’ 
(see snapshot), and the file(s) will be 
extracted, and the tags will get merged 
with your own set of tags. 
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C H A P T E R  1 8 
Synchronize

Organyze helps you synchronize folders in different machines (desktops, 
laptops), through the medium of storage devices like pen drives or a 
folder in a hard disk which will act as an intermediate storage device. 

By default, the synchronize module in Organyze does not delete files 
in the destination folder if they do not exist in the source folder. So you 
need not worry about loss of data as a result of synchronization. 

You can choose to synchronize selectively:
	l		 One-way (which is like a backup with the option of including some 

or all the tags) or two-way (default: one-way).

	l		 Include or exclude sub-folder (default: include).

	l		 Include or exclude various file formats (default: all).

	l		 Specify the date range for modified, created or accessed dates. The 
purpose of this feature: When you synchronize two machines with 
large storage spaces via a device like a pen drive with much less 
space, you may need to delete older contents of folders from the 
pen drive to create space. By setting dates, you ensure that older files 
are not copied to the pen drive all over again. 

l	 Include bookmarks, labels and comments.

You can save your synchronization settings (i.e., source and destination 
folders plus the other conditions mentioned above). Once you have saved 
these settings, whenever you need to sync a folder, just select the desired 
setting from a stored list and click on the button ‘Start sync’. You can also 
delete any of these settings, or edit them (such as when you wish to change 
the destination folder, or the inclusion or exclusion of any item or date range).

Note 1: 	 Why does Organyze not delete files while synchronizing? 
		 Let’s say you need to copy to your laptop, say, only 10 files 
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relevant to a client you are going to meet on your sales call, out 
of a total of 100 files in the source folder in your desktop; you do 
not copy the rest because it’s not needed. On your trip you edit 
three files and create two more files. On your return when you 
synchronize from the laptop to the desktop, the default setting 
in Organyze will merely copy the three edited files (which will 
overwrite the older ones) and the two new files to the desktop 
folder; it will not delete anything from the destination folder 
because it doesn’t exist (or has been deleted) in the source 
folder. So you end up with 102 files in your destination folder in 
the desktop. If you allowed delete, you would have only 12 files 
because the remaining 90 would get deleted.

Note 2: 	 Why not use backup instead of synchronization in this 
situation? The reason is that the synchronization function 
also backs up the tags to your files and folders. So, if you have 
added labels or comments to some of the 10 files you have 
carried with you on your trip, or to the two new files you have 
created, these labels will get transferred to the desktop folder 
(which doesn’t happen when you do a backup).

Note 3: 	 This doesn’t mean your labels cannot be backed up. In fact, 
your Organyze set-up will not allow you to begin using 
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the program until you have decided on a place to back up 
the ‘application data’, which means, primarily, your tags 
(bookmarks, labels, and comments) and related information 
and settings. You have to do this as part of your set-up only 
once, before you begin using Organyze; you will get a message 
the first time; the message will not recur after that.

Note 4: 	 You may attach bookmarks, labels and comments to files in 
a source folder without changing the files themselves in any 
way. In this case Organyze will sync the bookmarks, labels and 
comments with the destination folder without wasting time; 
overwriting files that have not been changed.

Note 5: 	 To sync from one machine to another in a network, first sync 
from the first machine to a folder in either machine or in a 
third machine, then sync from that folder to the destination 
machine. You can also use a pen drive as an intermediate 
medium instead of the in-between folder when you need to, 
for example, sync folders between your office machine and 
home machine. 

Note 6: 	 You can sync along with tags (label, bookmark, and comments) 
in one-way sync only.

Note 7:    You can now use Organyze to sync folders without using an 
intermediate device like a pen drive or part of a hard disk. 
Use this feature to extract tags from previously synchronized 
folders received from others.

There are two ways you can do this. In Windows Explorer right click on 
a folder, use the context menu to select Organyze and then ‘Extract
synced tags’ OR select Organyze in the system tray (at the bottom right 
of your screen), click ‘Extract synced tags’, and then browse to select a 
folder. Click the ‘Start extracting’ button. When the process is complete, 
the dialog box will close automatically. Now you can use the received 
tags. 
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C H A P T E R  1 9 
Back up

Organyze enables you to back up your files and folders in a way that 
you can configure the backup process once and then forget about 
it – by saving backup settings for a scheduled backup. It also gives you 
enormous flexibility in backing up different folders in different ways. 

Highlights:
l	 Back up an entire drive to another machine or to another drive in the 

same machine, or both.
 
l	 Back up different folders in a drive to different parts of different 

machines or to different drives in the same machine.

l	 In addition, back up your folders online to ensure greater 
insurance against any damage or destruction of the premises in 
which your machines are located.
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l	 Maintain several versions of backed-up files. Use a reasonable 
(optimum) number that best suits your needs.

l	 Ideally, maintain different numbers of versions for different folders 
[e.g., you may wish to maintain only one additional version of an 
archived folder, from which you may access files once in a rare while, 
but maintain many (say, five) versions of the most active folders, 
which you access every day, so that you can recall earlier content you 
have deleted on different days]. 

l	 Scheduled backup to assure automatic backup, or manual backup of 
fixed settings. 

	l		 There is no restore function for the back up of files and folders. 
The reason: unlike with some other backup software, Organyze 
backs up your files and folders in the normal way or, if you prefer 
it, in a compressed format. All you need to do is go to the location 
in which the backup is maintained, and open (or unzip and then 
open) the file.

Note 1: 		 THIS IS VERY IMPORTANT — Unless you’re backing up an entire 
drive every time (convenient to configure but not efficient, since 
it will slow down the process), you need to create fresh backup 
configurations for new folders you have created, which lie 
outside existing folders being automatically backed up. 

		 You need not bother about this if your new folders are inside 
existing folders that are being automatically backed up.

Note 2: 	 Backing up an entire drive at one go causes another difficulty: 
you cannot then set different numbers of versions (or other 
options) for different folders. All the folders will have to be set 
for the same number of versions; this means that either you 
will have too few versions for your active versions, or, if you set 
many versions for the entire drive (and hence all the folders in 
the drive), you could quickly run out of space in the destination 
drive or machine.

Note 3: 	 If you have Organyze installed on your machine, you can back 
up your folders on another machine, even if that machine does 
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not have Organyze; but folders from that machine cannot be  
backed up either on that machine or anywhere else if it does  
not have Organyze.

Backing up of application data
Organyze also enables you to back up your application data (labels, 
comments and bookmarks, and various settings, including your backup 
and synchronization presets) and your files and folders. 

For the scheduled backup to take place, please ensure that:

l	 Both your source and destination machines / drives are switched on 
and connected at the scheduled time. If they are not, Organyze will 
do a backup the next time both machines are switched on, even if it 
is not the scheduled time.

l	 Organyze is in active mode in the source machine (even if you are 
not using it, it should show in the system tray at right-hand bottom 
of your screen.

l	 For application data backup, keep 5 to 10 copies to be safe. 

l	 You can restore your application data backup whenever you 
re-install Organyze – so your application data (labels, comments 
and bookmarks, and various settings, including your backup and 
synchronization presets) can be retrieved. The restore information is 
stored in an XML file. 

		 Caution: Please make sure you restore from the latest file (an XML 
file stored in a place you have determined). If you restore from an 
earlier file, application data created after that XML file was created 
will not be retrieved. But don’t panic. If you do make a mistake, you 
can always do another restore, this time from the latest XML file; that 
will retrieve the latest application data.
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Check disk space
Organyze allows you to see information about disk space on your 
machine. This is useful because the information helps you avoid 
selecting drives with less space as destinations for backing up files from other 
drives.
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C H A P T E R  2 0 
Suggestions

1
Create order out of chaos!
Organyze can help you create order from chaos. See how:

When you download pages (files) from the Web using the Organyze 
labeling process, save them anywhere, preferably in a folder named by 
the date or month of the download (e.g., 201101 for January 2011). 

Now you’ve got chaos! You have a wide variety of files in a single folder.
Open the Organyze ‘Advanced search / manage’ window, call all files labeled, 
say, ‘Innovation’ for the date range 1 to 31 January 2011. Then select them all 
and move them to a folder or sub-folder called ‘Innovation’ (or ‘Innovation 
2011’ if the original folder or sub-folder has got too many files).

The labels and other tags attached to the files will remain intact.

Now you’ve got order out chaos!

2
On finding valuable old files and emails you’ve completely forgotten 
about, so that you can re-use previously created content instead of 
creating it all over again. How to do it? Here’s how:

Let’s say you have many drives in your machine and in an external hard disk, 
and the files date back 10 years. During these years you have sent out a few 
thousand letters, presentations, proposals and agreements to clients or 
potential clients; over half of them are archived in folders you rarely visit.

Now, when you’ve got to create a new proposal for a client, and need 
a certain type of information to be included (e.g., say, about separate 
charges for hosting of websites), you don’t have to try and remember 
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which of the various documents you’ve sent out have a hosting section 
or clause in them. Where past documents contain information about 
hosting, you have already labeled them with the label ‘hosting’ (besides 
other labels relating to what those documents contain).

You also know that the information you seek should be relatively recent. 
So you select the date range for the past three years, and the labels ‘hosting’ 
and ‘proposal’- and Organyze fetches the relevant documents instantly! You 
don’t have to go from one client folder to another, or search through your 
archives or, for that matter, through your recent folders.  

It’s so easy! Try this with old photographs, songs, and other files.

3
To see how fast you can find files with Organyze, try this: attach one 
of a couple of labels (say, ‘Testing’ and ‘Trial’) to many files in different 
folders, sub-folders and drives in your machine (using any of the 
methods described in previous chapters for attaching labels). Then open 
the ‘Manage files / folders’ window of Organyze, and select one of the 
labels. Almost instantaneously you will see a list of files with that label 
in the main work area (on the right). Select the other label; and you will 
immediately see a list of files with this other label. It really doesn’t matter 
where those files are stored. 

Think of how much time you have saved, which you would otherwise 
have spent going from drive to drive, folder to folder, sub-folder to 
sub-folder and scrolling up and down the lists to find what you needed. 
Think of how much time Organyze can help you save in a year! You 
may be releasing at least 10 to 15 days of time this way, which you could 
use to do other work – or see a movie, or just relax! 

This saving is in addition to the time and effort you save in other 
areas, including adding value to your files and folders, backing up, 
and synchronization – besides having the assurance of data safety 
that results from automatic, routine backups that happen very fast 
without your having to spend any time on them once you have 
configured them.
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4
Avoid clutter after automatic labeling

To avoid clutter caused by too many same-name labels, try this: let’s say 
you have a label ‘Innovation’ under a parent label ‘Management’, and 
your automatic labeling shows up another label ‘Innovation’ because 
that is the name of a folder or sub-folder somewhere in the path of your 
automatic labeling.

To clean up, after the auto-labeling is done, call all the files with the 
auto-labeled ‘Innovation’ label (it will be a separate label, not under 
‘Management’). Then select all the files (except those you think do not 
really fit the description ‘Innovation’ though you may have dumped 
them in the innovation sub-folder for convenience while downloading), 
and do this –

Detach the new ‘Innovation’ label; attach the ‘Innovation label’ 
under the ‘Management’ parent label; then delete the auto-created 
‘Innovation’ label. That will delete the label and also remove the 
‘Innovation’ label from the files you decided should not be tagged 
with the ‘Innovation’ label.

5
Tag your older files, folders and emails easily in the Organyze 
window, Windows Explorer, and MS Outlook

You can apply a label, bookmark, or comment simultaneously to many 
files in Windows Explorer and in the Organyze window. So if your files are 
organized with some basic classification method, you should be able to 
label a large number of your older files and folders in a short period. 
For emails, you can do this in MS Outlook and in the Organyze window.
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